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Introduction

Introduction

iQube is a light desktop translation tool integrated with server based translation 
memories and glossaries.
iQube receives pre-processed project segments from idioma’s TM Server eliminating 
the download of project packages.
Translation units are stored to a project-specific, server-based translation memory 
(TM). This TM builds up internal leverage as translation progresses.
iQube features terminology management and instant QA on bilingual segments.

System Requirements

Microsoft® Windows® XP with Service Pack 3; Windows Vista®;  Windows 7 or 
Windows 8
.NET Framework 4 Client Profile
It is however recommended to keep your OS updated.

Installing iQube

You can download the latest version of iQube from the following link:
https://tc6.idioma.com/software-updates/iQube.zip
Unzip the installer and run the installation application.

Installing Tome Spell Checkers

After iQube has been installed, the setup will continue with the installation of the 
Tome spell checkers. Please see “Tome Spell Checker” on page 10 for further details.

iQube Updates

At program start up you will be notified if a new version of iQube is available.
Click on the provided link to download the update. Unzip the installer and run the 
installation application.
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Starting iQube

Starting iQube

You can start iQube either directly from tc6.idioma.com after you have accepted a 
job or from your desktop. In both cases you need to enter an Access Code to open 
an iQube project.

Starting iQube From tc6.idioma.com

Log in to tc6.idioma.com to accept a job.

When you click on the Accept button, a pop-up window with instructions will open.
Instructions contain the Access Code for the job on the iQube TM Server.

Click on Start iQube With This Code to start iQube.

The login dialog box is pre-filled with the Access Code for the job you accepted.

Starting iQube From Your Desktop

Make sure you are connected to the Internet, launch iQube, enter the Access Code 
and click OK.

Please see “Starting iQube From tc6.idioma.com” on page 6 for detail on how to 
obtain the Access Code.

Type Access Code here
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Selecting a Project

Selecting a Project

In this next step you will be presented with a list of active projects.
Choose the project you want to open and click OK.

Projects can be of two types: Translation Project and Verification Project.

Project Types

Translation Project

Translate the assigned segments into your language‚ and before you confirm and 
finish the project‚ be sure to spell check and read through the translation to make sure 
it is free from typing errors‚ grammatical errors‚ etc.

Verification Project

Check and correct all spelling mistakes‚ grammar mistakes, obvious translation 
mistakes and mismatched numbers. If there is a number (digit) in the source text‚ the 
same number (digit) must be in the target text (i.e. not spelled out). Do not change 
style‚ expressions‚ etc. unless absolutely necessary. Enter all corrections directly and 
delete/change wrong parts.

Review Project

Each finished project is eventually subject to QA checks and segments that result to 
be in error are sent back to the original translator for review and repair.
Besides this, as Verifiers are allowed to make changes to translated text, segments 
edited by Verifiers are also returned to the original translator for final review (agree or 
disagree with change or correction).

No Project Assigned

You will get an alert in case no project is assigned to your account.
iQube will not open.
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iQube Editor

iQube Editor

When you select an active project, the iQube Editor opens showing the first segment 
to translate or verify. Project Preview opens alongside the iQube Editor.
See “Project Preview” on page 24 for further details.
Please note that MS Word also opens in the background as iQube is launched.
This is because iQube runs spelling and grammar check in MS Word. (If MS Word is not 
installed on your PC, iQube uses its own speller; spellers are not in use for Japanese and 
Chinese.).  Please see “Spelling And Grammar Check” on page 10 for further details.
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iQube Elements

The iQube Editor is made of the following main components:
1 Toolbar Use the buttons in the toolbar to perform a number of functions 

in iQube.
2 Project Information Here you can find detailed information about the current 

project.
3 Source text Here is where source text is displayed.
4 Fuzzy 1 / Editing Window Here you can enter or edit target text suggested from Translation 

Memories (TM).
5 Fuzzy 2  / Editing Window Displays additional suggestions from trained reference TMs 

(Future feature).
6 Fuzzy 1 Details Window Displays text differences regarding fuzzy matches shown in the 

Fuzzy 1 window.
7 Language Rules Window Language rules and formatting styles for the target language 

are shown here.
8 Glossary Window Glossary terms to be used in translation are displayed in the 

Glossary window.
9 PDF References Additional reference from aligned PDF files is shown here 

when available.
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Editing Window

Resizing iQube Components

The sizes of the iQube components can be re-arranged with mouse-dragging.
You can change the ratio between top and bottom part, and in each of them the ratio 
between left and right part).

iQube Utilities

iQube includes the following utilities:
Project Information Display

Click on the  icon to display additional information about the current project.
Character Counter

Char Count: 176  Counts the number of strokes in the target window.
Character Identifier

(„ 8222 $201E)  Shows the Unicode character code.
Comments

Use the  icon to add a comment.
Font Size

Use the  or  icons to increase or reduce font size in the Editing Window.
Character Map

Click on the  icon to open Windows Character Map.
Font Style

Click on the  icon to open Font Chooser where you can apply a font of your choice 
to text in the Editing Window.
Please note that only fonts available in your system will be displayed in the Font Chooser.

Symbol Window

Another useful utility in iQube is the Symbol Window a floating window which 
offers a selection of the most commonly used symbols. Double click on a symbol to 
insert it in the translation text area.
The Symbol Window also lists a selection of quotation marks. Quotation marks that 
should be used in target text are automatically highlighted for quick reference.
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Editing Window

Editing Window

The Editing Window is made up of the Source window and the Target window.
Source text to translate will appear in the upper Source window.
Enter translation in the lower Target window.
Press Enter or execute either [Ctrl]+[Enter] or [Alt]+[+] (on numeric keypad) to 
confirm translation and move to the next segment.

Spelling And Grammar Check

By default spelling and grammar check are run inside MS Word (open in the 
background) and reflected on text in the iQube target window.
As you type text in the target window, you will see the same text written in the MS 
Word document open in the background.

Tome Spell Checker

If for some reason the MS Word Spell Checker for your target language is not found 
on your PC, iQube will use the in-built Tome Spell Checker (MS Word will not 
open).

Setting Tome as Preferred Spell Checker

By default the MS Word spell checker is set as the main spell checker in iQube.
However in Preferences > Spellchecker you can set the Tome Spellchecker as the 
preferred spell checker.

Spellchecking Disabled

As iQube starts up, you may get a message warning you that initialization of the spell 
checker failed. This could be due to two reasons:

- �the spell checker for the project target language is not installed in your installation 
of MS Word nor is the Tome spell checker installed;

- �MS Word was already running when you started iQube. Please exit iQube, make 
sure MS Word is not running and try again.
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Editing Window

Spell Checker Suggestions

Just like in MS Word, right-click on the underlined term to obtain available 
suggestions from the spell checker.
You can also choose to add a term to the iQube local dictionaries.

Disabling Grammar Check

While spell check is always active, you can optionally turn off grammar check in 
preferences.

Autocomplete

When you type the first characters of a word, Autocomplete can suggest you a list of 
glossary terms that you can select and insert in your text.

Autocomplete is triggered by Ctrl+Space. A list of available terms is shown and 
filtered as you type.

You can select any of the suggested terms, .e.g. with arrow down or filter it by typing 
to a single item, and press Space OR Enter OR Tab to insert it.

You can close the autocomplete list by pressing the Escape key.

Suggested glossary terms
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Editing Window

TM Results

Every time you open a translation unit, iQube searches the server TM(s) for matches.
If one ore more translated segments are found in the TM(s), iQube prompts them 
to the translator.
The open TU will show the segment to translate in the source window while 
the matching or partially matching result (“fuzzy matches”) found in the TM is 
automatically inserted in the target window. Details are shown in the Fuzzy window.
Please see “Fuzzy Matches Window” on page 21 for further details.

Translating Tagged Segments

When working with tagged segments, it is important that all internal tags (text 
formatting commands) present in the source text are also reproduced in the translation 
(see example below).

Omitting formatting tags would cause damage to the final document format and layout.

Please note that with iQube you can work using useful hotkeys and keyboard shortcuts.
To learn about iQube hotkeys and shortcuts, please see “Hotkeys And Keyboard Shortcuts” on 
page 44

Tag View

In iQube you can change switch among three different tag views.

To change tag view select Preferences > Tags and chose among Short (Ctrl + 
Numpad 1), Middle (Ctrl + Numpad 2), Full (Ctrl + Numpad 3) and Display text 
(Ctrl + Numpad 4).

The Short view display tags in a compressed form (see image below)

The Middle view display tags in a partially compressed form (see image below)
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Toolbar

The Full view display tags in their complete form (see image below)

Display text display tags in their integrity showing all the text information included.

Please note that tags are always available in their full form in the Toolbar for quick 
reference and quick insert.

Automatic Tag Copy

Please note that on “no match” segments, formatting tags are automatically copied 
from the source segment and inserted in the target window.
You can however change this behavior in the in iQube Preferences.

Internal Repetitions

Internal repetitions are segments that repeat identically within a text.
Internal repetitions are indicated with the  icon in the Project Window.
Once you translate (and confirm) the first occurrence of a repeating segment, the 
segment will be stored in the TM and propagate automatically to all the other 
occurrences within the project. This means that when you get to the next occurrence of 
an already translated internal repetition, translation text will be entered automatically 
as a 100% match.
You will still be able to edit the translation of the automatically translated repetition 
in case you need to adjust translation to a different context.

Locked Internal Repetitions

Some projects may come with locked internal repetitions.
If a project has locked repetitions this will be indicated under Project Information in 
the iQube Editor (please see image below).

This means that automatically translated repetitions will be skipped in iQube as you 
proceed from segment to segment.
However also in case of locked internal repetitions, it will still be possible to edit an 
internal repetition.
To do so, in the Project Window locate the repetition segment you want to edit and 
click on Edit to open the segment in the Editing Window.
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Toolbar

Toolbar

You can use the toolbar buttons to perform the following actions:

Segments

Return to previously visited segment

Go to next visited segment

Terms

Get previous term

Get current term

Get next term

Tags

Get previous placeable

Get current placeable

Get tag group

Get next placeable

Clear all tags

Other

Delete target

Copy source to target

Concordance search

Submit translation and get next segment

Sending Feedback Messages

You can select Help > Send Feedback to send a feedback message to idioma with 
suggestions regarding the iQube application or to report a problem.
Type in your message and click Send to deliver your feedback to idioma.
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Glossary Window

Note On Feedback Messages

Please not that the Feedback function should only be used to submit feedback on 
iQube functionality or technical issues, not feedback on linguistic issues or questions 
related to translation projects!

Notifications

Notifications is a quick way for idioma to send brief information regarding iQube 
and the iQube server e.g. coming features, changes and updates etc.

Resizing the working area

Use the maximize, minimize, and close buttons in the top right corner of iQube to 
adjust the size of the working area.
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Glossary Window

Glossary Window

Glossary hits are displayed in the Glossary window in the upper right corner of the 
GUI.
The detected source term appears in red color with its corresponding target term in 
black color below.
The glossary name (in grey color) is also displayed as reference (see image below).

Source term

Target term

Glossary name

Glossary terms detected in source text are also underlined in the source segment.

Inserting Glossary Terms

Double-click on a target term to insert it into the translation.
Glossary hits may also have more alternatives. Also in this case, double-click on one 
of the available target terms to insert it

Target terms can be added to the target text also by hotkeys.
Please see “Hotkeys And Keyboard Shortcuts” on page 44 for details.

Title Casing

Title casing is automatically applied to inserted glossary terms.
You can disable title casing by selecting Turn off glossary title casing under 
Preferences.
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Glossary Window

Floating Glossary Window

Glossary terms are also displayed in a separate floating window with added 
functionality.
Please see “Shared Glossaries” on page 18 for further details.
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Glossary Window

Shared Glossaries

In iQube it is possible to add new terms to a Shared Glossary.
When you add a term to a Shared Glossary this term becomes available to all editors 
working on the same project.

Adding a Term to a Shared Glossary

Use the floating Glossaries Window to add a term to a Shared Glossary.
By default the Glossaries Window opens each time you launch iQube.
In case you have closed the Glossaries Window you can open it again by selecting 
Show > Secondary windows in iQube main toolbar.

On the Glossaries Window click on Create shared glossary, a dialog appears where 
you can enter a Source term and a matching Target term.

Additionally you can enter a Comment, a Variant and an additional Comment to 
the Variant.

Click on Submit to server to add the term to the Shared Glossary. You will see an 
“Upload successful” message as a confirmation that the term has been added to the 
Shared Glossary.

The added term will now be available to all editors working on the same project and 
will be displayed in the in-built Glossary Window in iQube.
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Empty Glossary

Empty Glossary

A project can include an Empty Glossary that is a glossary where only source terms 
are included. These source terms are displayed in the Empty Glossary window placed 
above the regular bilingual glossary window.

In case of an Empty Glossary, you are supposed to fill in the target terms for the 
listed source terms.

Adding Target Terms to an Empty Glossary

Execute Ctrl+Alt+E or double-click on an Empty Glossary term to open the 
Translate glossary item editing window. Here you can provide a translation for the 
empty glossary source term.

Type your translation in the empty Target field and click on Add to move it to the
Created list of terms. The entered term will be marked as “Mine”.

Select a new term (if available) from the drop-down term bar.

When all terms have been translated, click OK to confirm.

Use the Delete button to remove a term from the list.

To replace a translation with a different one, type text in the Target field and click on 
Change to replace the existing translation.

If you attempt to confirm a translated segment with missing empty glossary target 
terms, a warning message will prompt you to provide a translation for the source 
terms.
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Empty Glossary

Suggesting a Different Term

An Empty Glossary can be shared by more users (e.g. in a shared iQube project).

A term may have already been entered by a different user ( in this case the “Mine” 
checkbox related to this term is not ticked) but you can still replace this term with a 
term of your choice.

In order to replace an existing term with your own translation, please follow the 
instructions given in “Adding Target Terms to an Empty Glossary” on page 19 

Proposing a Term for Removal

You cannot delete terms provided by other uses but you can propose their removal.
Select the term you want to propose for removal and click Delete.

Click Yes to confirm your choice.

Please keep in mind that if you suggest a term for removal, you will be prompted to 
provide an alternative target term as replacement for the discarded term.



21 - iQube

Fuzzy Matches Window

Fuzzy Matches Window

What’s a Fuzzy Match?
Fuzzy matching is a technique used in computer-assisted translation. It works with 
results that may be less than 100% perfect when finding matches between segments 
of source text and entries in a database of previous translations.
When an exact match cannot be found in the TM database for the text being 
translated, iQube searches the database to locate segments that are an approximate 
match for a segment in a new source text to be translated. iQube “proposes” the 
match to the translator; it is then up to the translator to accept this proposal or to edit 
this proposal to fully match with the new source text that is being translated.

Fuzzy Match Results in iQube

Fuzzy matches are automatically inserted in the target window on an orange 
background.

Details on the fuzzy match are shown in the Fuzzy window in the lower part of 
the GUI right below the target window. In the Fuzzy window mismatched text is 
highlighted in either grey or yellow color.



22 - iQube

Fuzzy 2

Switching Between Fuzzy Match Results

More fuzzy matches can be displayed for the same source segment.
You should focus on one of the suggested translations and adjust it to match the text 
to translate.

You can use arrows to the left and right of the fuzzy match value to switch from one 
fuzzy result to the other.
Please note that when a 100% match is available the arrow pointing in the direction 
of the 100% match is colored green.

Fuzzy 2
Fuzzy 2 is a feature that displays suggestions from secondary trained databases.
These trained suggestions include glossary terms; numeric values match those in 
source text. To use the Fuzzy 2 window, double-click inside the window to activate 
it. Please read, edit and correct text carefully, being particularly careful that the 
translation exactly matches the source original. When ready press Enter to confirm 
the segment.

Please note that when Fuzzy 2 is active, Fuzzy 1 Details and PDF References are 
disabled. 

Language Rules Window

The Language Rules window acts as a reminder of the correct formatting styles 
required for the target text.
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Project Information

Project Information

The Project Information window displays all data related to the open project.

The information includes:

- Project name
- Assigned translator(s)
- Manufacturer’s name
- Source and Target languages
- Number of translated segments
- Total number of segments
- Number of processed words
- Total number of words.

A progress bar indicates project progress based on the number of segments translated.

Segment Information

The Segment Information window displays all data related to current segment.

The information includes:

- Segment number
- Segment server  ID
- Segment status
- Number of words in current segment.

PDF References

Additional references can be provided through PDF References when available.
PDF References are displayed in a similar way to fuzzy matches and are produced by 
PDF document pairs previously segmented and synchronized by the iQube Server.

You can click on Show document to display text as it appears in the PDF documents.

PDF text preview will be opened inside your default Internet browser.
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Project Preview

Project Preview

Choose Show > Secondary windows to open the Project Preview window and view 
all project segments.
Project segments may have different statuses. Please see “Segment Statuses” on page 27 
for more details.

Browsing Project Segments

Use the orange arrow keys in the top-right corner of the Project Preview window 
to move upwards and downwards through project segments.

Ctrl+Down and Ctrl+Up will get respectively to the next and previous segments to 
be edited skipping the ones that have already been confirmed.

Changing Font Size in Project Preview

You use the font size slider at the bottom of the Project Preview window to change 
the overall font size of text in the Project Preview window.

Editing A Segment

Select either source or target text and click on Edit or press Enter to open and edit 
the selected segment in the iQube Editor.

Once you have edited a segment, execute [Ctrl]+[Enter] (or [Alt]+[+] on numeric 
keypad) to confirm and submit the segment.

Locked Segments

Segments assigned to other editors are view only and will appear on a light grey 
background with no status. Target text is added as project progresses and segments are 
confirmed.
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Project Preview

Find and Replace

You can use the Find and Replace function in the Project Preview to search for 
every occurrence of a specific word or text string and replace it with new text.

Click on the  icon in the top right corner of the Project Preview window to open 
the Find and Replace dialog box.

Enter the word or text string you want to search for in the Find text box.
Enter the replacement word or text string in the Replace text box.

Click the Replace button to proceed.
A confirmation dialog opens, click OK to continue.

You can use the Match case option to run a case sensitive search.
You can search for whole words only by checking the Whole words option.

Please note that the search and replace function applies only to Translated segments  
( ) (Translation) and Confirmed segments ( ) (Verification).

Confirming Changes

Please note that although replacements are performed automatically, you will still 
have to confirm the pending changes.
A message warning you about pending changes pops up if you try to Confirm & 
Finish a project with unconfirmed replacements.

You can use the Segment Filter to sort segments by State.
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Project Preview

Segment Status Change (Translation)

Translated segments ( ) will be reverted to the Draft status and marked by the  
icon indicating pending changes.

To confirm the segment (Ctrl+Enter), click on Edit to open the segment in the 
Editing Window.

Segment Status Change (Verification)

Verified segments ( ) will be reverted to the Confirmed status and marked by the 
 icon indicating the pending changes.

To confirm the segment (Ctrl+Enter), click on Edit to open the segment in the 
Editing Window.
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Segment Statuses

Project segments may have three different statuses. These statuses are marked with 
different icons. The three status icons are different depending on whether you are 
assigned to the project as translator, verifier or reviewer.

Confirm and Finish

The Confirm & Finish button in the Project Window sets - depending on the project 
type -  Translated, Verified and Revised segments to the Confirmed status.
Confirmed (and finished) segments become uneditable.
Please see the following chapters for further details.

Translation Statuses

At project start all segments have the Draft status. This status changes to Translated 
once translation has been set. By clicking on the Confirm & Finish button, translated 
segments change their status to Confirmed.

Please note that Confirmed segments are locked to the translator and become 
automatically available for the verifier.

Please also note that segments marked as Draft may either have no TM match or a 
fuzzy match (70 to 100%).

Fuzzy match values are displayed under the Match column as shown in the example 
below.

Status Icon Match Condition
Draft No match in TM

Draft 75% Fuzzy match found in TM

Draft 100% 100% match found in TM

Translated Translation set

Confirmed Translation confirmed
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Segment Statuses

Verification Statuses

At project start all segments have the Confirmed status. Segments marked by the  
icon indicate 100% matches that have been edited and confirmed.
This status changes to Verified once translation has been verified. By clicking on 
the Confirm & Finish button, Verified segments change their status to Verified and 
Confirmed.

Status Icon Match Condition
Confirmed Confirmed segment

Confirmed Confirmed segment 
(Edited 100% match)

Verified Translation verified

Verified and Confirmed Translation verified and confirmed

Please note that Verified and Confirmed segments are locked to the verifier.
Please also note that segments edited by a verifier are automatically sent back to the 
translator for a final review.

Review Statuses

When a verifier edits a confirmed segment and indicates the reason for the change 
(please see “Verification Report” on page 40), the edited segments are returned to the 
original translator for a final review.

Review too is a three-step process where segments go from Verified Confirmed to 
Revised and by clicking on the Confirm & Finish button, Revised segments change 
their status to Verified and Confirmed.

Verified Confirmed Confirmed segment

Revised Translation verified

Revised Confirmed Translation verified and confirmed

Correction Statuses

Coordinators can reassign finished segments to a corrector (or “referee”) in case errors 
are still reported at the final QA process.

CrossChecked Confirmed segment

Corrected Translation verified

Corrected Confirmed Translation verified and confirmed
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Filter

Use the Filter function to locate text inside project segments.
Under Filter type the text you need to search and click on the  icon or hit Enter 
to display only segments containing the text you entered. 
Click on the  icon to clear the filter and restore the complete project view.

Filter Options

You can refine your search selecting one of the pre-defined filter options from the 
available drop-down list.

The available filter options are:

Source or Target finds searched text in source or target segments
Source finds searched text in source segments only
Target finds searched text in source segments only
# finds segments by number
Match at least displays segments by a minimum Match rate set by user
Pending changes displays segments with changes (introduced by “find and 

replace”) waiting for confirmation
Spelling errors displays segments with spelling errors

Filter Segments by Status

You can also filter segments by their status (e.g. “Untranslated or “Verified and confirmed”)
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Sorting Segments

You can also sort segments in ascending or descending order by clicking on a column header.

Concordance Search

Concordance Search allows you to search the translation memories assigned to a project 
for whole sentences or text fragments similar or identical to the text you are translating.

Press F3 to open the Concordance window. Type the text you need to search in the 
search box and click on the  icon or hit Enter to display only segments containing 
the text you entered. 
You can also select text directly in the iQube Editing Window and press F3. Search 
for the selected text will be run automatically.
Click on the  icon to clear text and search results.

Google Translate™ in Concordance Search

In the Concordance window, along with results from the project translation memories 
(when available), you may also find Google Translate™ translations.

Please note that Google Translate™ applies only to single words and text strings to 
a maximum of 5 consecutive words. Single words or text strings including project 
glossary terms will not produce any Google Translate™ results.
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Optional Consistency Check

When you click on Confirm & Finish in the Project Window, you will be asked if you 
want to proceed with consistency check on the translated segments.
This is an optional task:

- �click Yes if you want to run a consistency check on the translated segments before 
confirming and finishing the translated segments;

- �click No if you want to skip the consistency check and confirm and finish the 
translated segments.

Consistency Check Button

You can also use the Consistency Check button in the Project Window to check 
translated segments for translation consistency at any stage of the translation process.

Use this button to run a consistency check 
on translated segments

For further details on Consistency Check please see “Consistency Check” on page 40.
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Quality Assurance (CrossCheck)
Each time you close a segment to move to the next one (“Get Next”) a QA check is 
executed on target text.
Target text is cross-checked against source text and a Warning message pops up when 
a mismatch is detected (e.g. a number mismatch, a missing or superfluous tag, etc.)

If you still think the target segment presents no real error then you can also choose to 
ignore the warning message and click on Continue to confirm the current segment 
and get to the next. Click otherwise Back to edit the segment.

Confirmation

Please note that in case of critical warning messages related to a Different order of tags 
and Missing numbers or Superfluous numbers, you will be asked to first confirm your 
choice by ticking an OK checkbox before you can activate and select the Continue button.

Hit Tab followed by Spacebar to tick the checkbox.

Watch Your Language!

Terminology Check

When working with glossaries, QA watches the correct use of terminology.
A warning message is displayed when a source term is not translated 
according to the project glossary.

Opposite Terms

QA watches that common expressions like e.g. “Up” and “Down” or 
“In” and “Out” are correctly translated. This check is based on a default 
glossary listing different target language alternatives for common English 
expressions.

Forbidden Terms

Some projects may have a blacklist of forbidden terms.
A warning message is displayed when a forbidden term is used in a translation.
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Warning for Unchanged Fuzzy Match

The QA engine sends a warning when you confirm a fuzzy match that has been 
inserted as is without any editing.

This warning is aimed at bringing your attention to those cases where high fuzzy 
matches,  that still require small but critical adjustments, might get accepted and 
confirmed without the required changes.

Ignore Identical Errors

In case of Identical Segments and Character-Digit Combination reports, you can 
choose to ignore all identical reports in case these result to be recurring false positives.
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Warning for Spelling Mistakes

The QA engine sends a warning when you confirm a segment that contains spelling 
mistakes.

In such case you can take the following actions:

Back Return to the segment.
Ignore all �All occurrences of the misspelled word will still be marked in the editing window 

but not reported as an error by the QA engine.
Add to dict �The word is added to the dictionary and it will no longer be marked as a spelling 

mistake or a QA error.
Continue Ignores the current occurrence

Please note that the speller is based on MS Office’s built-in speller. Similar to 
performing standard spell-checking in Word, this speller operates in real-time on 
the open segment. 

Any words that you - or someone else - decide to add to the dictionary will not be 
flagged in the future. We hope this feature will save time, but we also would like you 
to really make sure a word is correctly spelled before adding it to the dictionary.

If you do not have MS Office, the speller will be replaced by a comprehensive open 
source spell checker.
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Limitation of Strokes and Lines

In certain projects the length of translation texts may be limited to a maximum 
number of strokes and/or lines (e.g. texts in display messages).
The QA engine in iQube keeps count of input strokes and lines and sends out 
warnings when limitations are exceeded.
These limits are displayed in the Segment Limits floating window which includes a 
character and line counter. When a limit is exceeded numbers in the floating window 
counter turn red.

Character Limit Check

If the max character limit is exceeded, a QA warning message is displayed and it will 
not be possible to confirm the segment unless the translation is edited and its length 
kept within its limit or an explanation comment is provided.

The target exceeds the character limit 70 for 
this segment. Please change your translation 
or provide an explanation comment.

Click OK to close the Character limit exceeded warning and return to the Editing 
Window or enter a comment.

Adding a Comment

Comments can be added by clicking on the comment icon ( ) in iQube.

Once a comment has been provided, you will be able to confirm the segment even 
though it exceeds the maximum number of strokes allowed.

Note to Verifier
In case of segments with exceeding strokes or lines, you can choose to agree with the 
translator’s explanation comment or choose to fix the issue.
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Line Limit Check

Line breaks are marked by the Newline(LF)  tag. Each line break tag indicates a new line.

You can use the Newline(LF)  tag to create a new line in your translation.

If the number of allowed lines is exceeded, a warning message is displayed. Also 
in this case it will not be possible to confirm the segment unless the translation is 
edited and the number of lines is kept within the assigned limit or an explanation 
comment is provided.

Adding a Comment

Comments can be added by clicking on the comment icon ( ) in iQube.

Once a comment has been provided, you will be able to confirm the segment even 
though it exceeds the maximum number of lines allowed.

Note to Verifier
In case of segments with exceeding strokes or lines, you can choose to agree with the 
translator’s explanation comment or choose to fix the issue.
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Line Length Limit Check

In certain segments there can be a limitation on the maximum number of strokes 
allowed per each line.

If the max character limit per line is exceeded, a QA warning message is displayed 
and it will not be possible to confirm the segment unless the translation is edited and 
its length kept within its limit or an explanation comment is provided.

The length of lines is defined by the Newline(LF)  tag.
Reposition the Newline(LF)  tag to modify line lengths.

Adding a Comment

Comments can be added by clicking on the comment icon ( ) in iQube.

Once a comment has been provided, you will be able to confirm the segment even 
though it exceeds the maximum number of strokes per line allowed.

Note to Verifier
In case of segments with exceeding strokes, lines or strokes per line, you can choose 
to agree with the translator’s explanation comment or choose to fix the issue.
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Verification

During the Verification process you will revise and confirm segments translated by 
another editor. Check and correct all spelling mistakes‚ grammar mistakes, obvious 
translation mistakes and mismatched numbers. Do not change style‚ expressions‚ etc. 
unless absolutely necessary. Enter all corrections directly and delete/change wrong parts.
The purpose of verification is to make sure the translated text matches the original. 
Do not make unnecessary corrections.
Make sure all titles and title references are unified‚ including any Table of Contents.

Verification Batches

Please note that translators may confirm and finish segments in batches. In such 
cases you will get only a part of the verification task while more segments will be 
available at a later time as translators confirm and finish more segments. A warning 
message will inform you when you open a verification batch.

Verification Window

When you work on a project as verifier, the Editing Window will be split into the 
following 3 parts:

Source Original text
Translation Translated text
Verification Editable copy of the translated text

In the Verification Window you can edit the translated text if necessary.
Execute either [Ctrl]+[Enter] or [Alt]+[+] (on numeric keypad) to confirm translation 
and move to the next segment.
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100% Matches

In case of 100% matches text to be verified is displayed on a green background.

Edited 100% Matches

When a translator edits a 100% match, the changes made by the translator are marked 
in Translation text and/or the Fuzzy Details window.

Edited 100% matches are also marked by the  icon in the Project window for 
quick reference.
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Verification Report

Each time you edit and confirm translated segments, iQube will prompt you to fill 
a Verification Report (see image below) where you will indicate the number of 
changes per type.

Please note that you need to enter at least one report to be able to submit your 
changes.

Please also note that the result of your verification will be forwarded to the original 
translator. If there are many errors, this will reduce his/her score, possibly resulting in 
payment deductions. Similarly, if you enter unnecessary corrections, we may reduce 
your score.

Consistency Check

In a Verification project when you click on Confirm and Finish in iQube, you may 
get a message warning them about possible Consistency issues.
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When you click OK, you will be shown a dialog with the inconsistent segments detected 
by the QA engine. Here you can choose to edit segments or dismiss a report (“This is 
OK”).

Next time you click on Confirm and Finish, the dismissed cases will not come up 
again. These segments will however come up again if you disconnect and connect 
again to the project while these segments are not yet confirmed.

Ignore unverified segments

Click on Ignore unverified to exclude those segments that have yet to be translated. 

Consistency issues have to be solved or ignored before a segment can be confirmed 
and finished as a confirmed. Please remember that confirmed and finished segments 
cannot be edited anymore.
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Review

When a verifier edits a translated segment (correction or change) and indicates an 
error (please see “Verification Report” on page 40) the edited segment is returned to 
the original translator as Review Project.
In the Review Project Reviewers will see their own translation and the verified 
version. Differences are highlighted. It’s possible to choose whether to agree with the 
edited version or not (see image below).
Hit Enter to agree and confirm the segment.

Review Batches

Please note that verifiers may confirm and finish segments in batches. In such cases 
you will get only a part of the review task while more segments may be available at 
a later time as verifiers confirm and finish more segments. A warning message will 
inform you when you open a review batch.

A plus sign next to the total segment count will also indicate that you may be working 
on a review batch.
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Editing A Verified Segment

To edit the verified version, do the following:

- Uncheck the I agree with verifier option to unlock target text
- Edit translation
- Hit Enter to confirm

See “Review Statuses” on page 28 for more details. 

Adding Comments

 If you need to add a comment to a review segment, click on the  icon to open the 
Comment Window.

Please type your comment inside the Comment Window, as shown below, and click 
OK to confirm.

Click here to enter a 
comment to segment

Important
Do not type comments in the Review window as they may end up in the 
final translated document!
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Hotkeys And Keyboard Shortcuts

Editor Shortcuts

Hotkey Action Icon Hotkey Action Icon

Alt + Ins Copy source to target Ctrl+Numpad 1 Short Tag View

Enter
Ctrl + [Enter]
Alt + [+]

Get next segment Ctrl+Numpad 2 Middle Tag View

Alt + Delete Delete target Ctrl+Numpad 3 Full Tag View

F3 Concordance search Shift + F3 Change Case

Alt + Left Get previous term Ctrl+Shift+Space Ins. nonbreaking 
space

Alt + Down Get current term Tab Open Project 
Preview

Alt + Right Get next term

Ctrl+Alt+Left Get previous placeable

Ctrl+Alt+Down Get current placeable

Ctrl+Alt+Right Get next placeable

Ctrl+Shift+Down Get current placeable 
group

Ctrl+Delete Clear all tags

Project View Shortcuts

Hotkey Action

Arrow Down Get to next segment

Arrow Up Get to previous segment

Ctrl + Down Get to next untranslated segment

Ctrl + Up Get to previous untranslated segment

Enter Open segment for editing
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Tips

Spelling And Grammar Check In MS Word

When using MS Word to run spelling and grammar check on iQube segments, you 
could arrange your open windows so that the MS Word document (where text being 
typed in iQube is entered for checking) is also clearly visible.

This way you can take full advantage of the spelling and grammar check in MS Word:

- You can see a detailed grammar check report

- You can add to dictionary recurring terms not recognized by MS Word

Simply right-click on the highlighted term to add it to the dictionary (please see 
image above).

Inserting nonbreaking Spaces

Select Edit > Insert non-breaking space (Ctrl + Shift + Space) to enter a nonbreaking 
space in target text.

Change Text Case

Select Edit > Change case (Ctrl + F3) to change chase of selected text.



46 - iQube

FAQ

FAQ
Q:	 How do I save my translation?
A:	� You don’t need to save your translation. Each segment you submit via iQube is 

automatically stored to the idioma online database.
Q:	 How do I submit my translation?
A:	� When you have completed your translation, select View > Project and click on 

Confirm & Finish.
Q:	 The working area is too small.
A:	� You can use the maximize, minimize, and close buttons in the top right corner of 

iQube to adjust the size of the working area.
Q:	 When I start iQube, I get a message saying “spell checker was disabled”
A:	� iQube uses MS Word spell checkers. Please make sure that the appropriate spell 

checker is installed in MS Word.
Q: �How do I make partial deliveries and will I be able to work on the rest of the 

project after I confirm a part of the translation?”
A:	� You can make partial deliveries by pressing the Confirm and Finish button. This 

will send the segments you have translated so far for verification, while you can 
continue working on the rest of the translation.

Q: �How can I enter a comment to review segment?”
A:	� You can enter a comment to a review segment by clicking on the  icon placed 

right under the Review window. Never type comments inside the Review 
window!
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iQube Menus at a Glance

Show

Show Preferences Edit Help

1 Secondary Windows
Shows Project window and Glossary window

2 Reset windows positions
Resets windows to default size and position

3 Restart application
Restarts iQube and reloads current job

Preferences

Show Preferences Edit Help

1 Grammar checking
Shows Project window and Glossary window

2 Spellcheck
Resets windows to default size and position

3 Automatic tag copy
Restarts iQube and reloads current job

4 Turn off glossary title casing
No title casing applied to glossary terms when 
inserted into target text

5 Ask before closing
Enables/Disables confirmation message before 
closing iQube

6 Tags
Sets tag view in iQube (see “Tag View” on page 12)

7 Original PDF
Sets PDF view in iQube

8 Change keyboard shortcuts
Opens shortcuts settings

Edit

Show Preferences Edit Help

1 Change case
Changes text case

2 Insert non-breaking space
Inserts non-breaking space (also 
known as a hard space or fixed 
space. In Unicode, it is encoded 
as U+00A0)
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Help

Show Preferences Edit Help

1 Custom spelling dictionaries
Opens folder with custom word list 
(see “Spell Checker Suggestions” on 
page 11)

2 User guide
Opens User Guide PDF

3 Change log
Opens iQube development history

4 Send Feedback
Use this form to send feedback to 
iQube support

5 Send backup logs
Sends iQube logs to iQube support

6 About
Checks iQube version
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